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Copyright
Copyright © 2008 Nokia. All rights reserved.

Reproduction, transfer, distribution or storage of part or all of the contents in this document in any form
without the prior written permission of Nokia is prohibited.

Nokia, Nokia Connecting People, and Nokia X and Y are trademarks or registered trademarks of Nokia
Corporation. Other product and company names mentioned herein may be trademarks or tradenames of
their respective owners.

Nokia operates a policy of continuous development. Nokia reserves the right to make changes and
improvements to any of the products described in this document without prior notice.

Under no circumstances shall Nokia be responsible for any loss of data or income or any special, incidental,
consequential or indirect damages howsoever caused.

The contents of this document are provided "as is". Except as required by applicable law, no warranties of
any kind, either express or implied, including, but not limited to, the implied warranties of merchantability
and fitness for a particular purpose, are made in relation to the accuracy, reliability or contents of this
document. Nokia reserves the right to revise this document or withdraw it at any time without prior notice.

The availability of particular products may vary by region.

IMPORTANT
This document is intended for use by qualified service personnel only.
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Warnings and cautions

Warnings
• IF THE DEVICE CAN BE INSTALLED IN A VEHICLE, CARE MUST BE TAKEN ON INSTALLATION IN VEHICLES FITTED

WITH ELECTRONIC ENGINE MANAGEMENT SYSTEMS AND ANTI-SKID BRAKING SYSTEMS. UNDER CERTAIN FAULT
CONDITIONS, EMITTED RF ENERGY CAN AFFECT THEIR OPERATION. IF NECESSARY, CONSULT THE VEHICLE DEALER/
MANUFACTURER TO DETERMINE THE IMMUNITY OF VEHICLE ELECTRONIC SYSTEMS TO RF ENERGY.

• THE PRODUCT MUST NOT BE OPERATED IN AREAS LIKELY TO CONTAIN POTENTIALLY EXPLOSIVE ATMOSPHERES,
FOR EXAMPLE, PETROL STATIONS (SERVICE STATIONS), BLASTING AREAS ETC.

• OPERATION OF ANY RADIO TRANSMITTING EQUIPMENT, INCLUDING CELLULAR TELEPHONES, MAY INTERFERE
WITH THE FUNCTIONALITY OF INADEQUATELY PROTECTED MEDICAL DEVICES. CONSULT A PHYSICIAN OR THE
MANUFACTURER OF THE MEDICAL DEVICE IF YOU HAVE ANY QUESTIONS. OTHER ELECTRONIC EQUIPMENT MAY
ALSO BE SUBJECT TO INTERFERENCE.

• BEFORE MAKING ANY TEST CONNECTIONS, MAKE SURE YOU HAVE SWITCHED OFF ALL EQUIPMENT.

Cautions
• Servicing and alignment must be undertaken by qualified personnel only.

• Ensure all work is carried out at an anti-static workstation and that an anti-static wrist strap is worn.

• Ensure solder, wire, or foreign matter does not enter the telephone as damage may result.

• Use only approved components as specified in the parts list.

• Ensure all components, modules, screws and insulators are correctly re-fitted after servicing and
alignment.

• Ensure all cables and wires are repositioned correctly.

• Never test a mobile phone WCDMA transmitter with full Tx power, if there is no possibility to perform the
measurements in a good performance RF-shielded room. Even low power WCDMA transmitters may disturb
nearby WCDMA networks and cause problems to 3G cellular phone communication in a wide area.

• During testing never activate the GSM or WCDMA transmitter without a proper antenna load, otherwise
GSM or WCDMA PA may be damaged.
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For your safety

QUALIFIED SERVICE
Only qualified personnel may install or repair phone equipment.

ACCESSORIES AND BATTERIES
Use only approved accessories and batteries. Do not connect incompatible products.

CONNECTING TO OTHER DEVICES
When connecting to any other device, read its user’s guide for detailed safety instructions. Do not connect
incompatible products.

RM-470
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Care and maintenance
This product is of superior design and craftsmanship and should be treated with care. The suggestions below
will help you to fulfil any warranty obligations and to enjoy this product for many years.

• Keep the phone and all its parts and accessories out of the reach of small children.

• Keep the phone dry. Precipitation, humidity and all types of liquids or moisture can contain minerals that
will corrode electronic circuits.

• Do not use or store the phone in dusty, dirty areas. Its moving parts can be damaged.

• Do not store the phone in hot areas. High temperatures can shorten the life of electronic devices, damage
batteries, and warp or melt certain plastics.

• Do not store the phone in cold areas. When it warms up (to its normal temperature), moisture can form
inside, which may damage electronic circuit boards.

• Do not drop, knock or shake the phone. Rough handling can break internal circuit boards.

• Do not use harsh chemicals, cleaning solvents, or strong detergents to clean the phone.

• Do not paint the phone. Paint can clog the moving parts and prevent proper operation.

• Use only the supplied or an approved replacement antenna. Unauthorised antennas, modifications or
attachments could damage the phone and may violate regulations governing radio devices.

All of the above suggestions apply equally to the product, battery, charger or any accessory.
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ESD protection
Nokia requires that service points have sufficient ESD protection (against static electricity) when servicing
the phone.

Any product of which the covers are removed must be handled with ESD protection. The SIM card can be
replaced without ESD protection if the product is otherwise ready for use.

To replace the covers ESD protection must be applied.

All electronic parts of the product are susceptible to ESD. Resistors, too, can be damaged by static electricity
discharge.

All ESD sensitive parts must be packed in metallized protective bags during shipping and handling outside
any ESD Protected Area (EPA).

Every repair action involving opening the product or handling the product components must be done under
ESD protection.

ESD protected spare part packages MUST NOT be opened/closed out of an ESD Protected Area.

For more information and local requirements about ESD protection and ESD Protected Area, contact your local
Nokia After Market Services representative.
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Battery information
Note: A new battery's full performance is achieved only after two or three complete charge and
discharge cycles!

The battery can be charged and discharged hundreds of times but it will eventually wear out. When the
operating time (talk-time and standby time) is noticeably shorter than normal, it is time to buy a new battery.

Use only batteries approved by the phone manufacturer and recharge the battery only with the chargers
approved by the manufacturer. Unplug the charger when not in use. Do not leave the battery connected to
a charger for longer than a week, since overcharging may shorten its lifetime. If left unused a fully charged
battery will discharge itself over time.

Temperature extremes can affect the ability of your battery to charge.

For good operation times with Li-Ion batteries, discharge the battery from time to time by leaving the product
switched on until it turns itself off (or by using the battery discharge facility of any approved accessory
available for the product). Do not attempt to discharge the battery by any other means.

Use the battery only for its intended purpose.

Never use any charger or battery which is damaged.

Do not short-circuit the battery. Accidental short-circuiting can occur when a metallic object (coin, clip or
pen) causes direct connection of the + and - terminals of the battery (metal strips on the battery) for example
when you carry a spare battery in your pocket or purse. Short-circuiting the terminals may damage the battery
or the connecting object.

Leaving the battery in hot or cold places, such as in a closed car in summer or winter conditions, will reduce
the capacity and lifetime of the battery. Always try to keep the battery between 15°C and 25°C (59°F and 77°
F). A phone with a hot or cold battery may temporarily not work, even when the battery is fully charged.
Batteries' performance is particularly limited in temperatures well below freezing.

Do not dispose of batteries in a fire!

Dispose of batteries according to local regulations (e.g. recycling). Do not dispose as household waste.
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Company policy
Our policy is of continuous development; details of all technical modifications will be included with service
bulletins.

While every endeavour has been made to ensure the accuracy of this document, some errors may exist. If
any errors are found by the reader, NOKIA MOBILE PHONES Business Group should be notified in writing/e-
mail.

Please state:

• Title of the Document + Issue Number/Date of publication

• Latest Amendment Number (if applicable)

• Page(s) and/or Figure(s) in error

Please send to:
NOKIA CORPORATION

Nokia Mobile Phones Business Group

Nokia Customer Care

PO Box 86

FIN-24101 SALO

Finland

E-mail: Service.Manuals@nokia.com
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 Product selection
RM-470 (Nokia 6700 classic) is a GSM/WCDMA dual mode phone, supporting EGSM850/900/1800/1900 and
WCDMA bands I, II and VIII.

Figure 1 RM-470 (Nokia 6700 classic) product picture

 Phone features

Display and keypad features
• 2.2" QVGA display with 16M colors

• 5-way Navi key (soft keys, send and end)

• Side-keys for volume up and down and camera capture

Hardware features
• Main camera: 5 megapixel camera with autofocus and integrated flash

• Internal GPS receiver

• MicroUSB connector/charger plug for data transfer (USB 2.0), charging and headset

• High speed USB (FS/HS/OTG)

• 2 mm charger plug interface

• Bluetooth version 2.1

• microSD memory card connector

• Stereo Music Player

• Integrated handsfree speaker

• Active noise cancelling (uplink)

• Internal vibra and antennas

• Plug-in SIM 1.8V and 3.0V, more than 1000 entries

RF features
• GSM/EDGE 850/900/1800/1900

RM-470
General information
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• WCDMA band I, II and VIII

• High speed upload - HSUPA cat 5 (2.0 Mbps)

• High speed download - HSDPA cat 9 (10.2 Mbps)

• EDGE: MSC 32

• GPRS: MSC 32

• HSCSD, CSD for browsing and as data modem

 Software and user interface features

Selection of software application and features
• OMA DRM 2.0 (Digital Rights Management)/Windows media DRM

• OMA MMS 1.3, MMS Conformance 3.0, AMR, and SMIL

• OMA Client Provisioning 1.1

• SyncML (local and remote)

• Java

• Music Player supporting MP3, MPEG4, AAC, eAAC+, WMA

• OMA DM 1.2 and FOTA with FUMO 1.0

• Calendar with today view in active standby mode

• Instant messaging

• VoIP

• Wideband AMR

• Nokia OSS Internet Browser

• Macromedia Flash Lite 3.0

• Nokia PC suite

 Accessories

Sales package contents
• Nokia 6700 classic phone

• Nokia Battery BL-6Q

• Nokia High Efficiency Charger AC-8

• Nokia Wired Headset WH-203

• Nokia Micro USB Cable CA-101

• 1 GB MU-22 MicroSD card

• User Guide

Table 1 Battery and chargers

Type Name

Note: This phone is charged through the smaller Nokia standard charger interface (2.0 mm plug). A 3.5
mm compatible Nokia standard charger can be used together with the CA-44 charger adapter.

BL-6Q Battery 960 mAh Li-Ion

AC-8 High efficiency charger

AC-6 USB charger

RM-470
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Table 2 Car accessories

Type Name

CK-100 Bluetooth car kit

DC-9 Mobile charger

HK-510 Plug-In car kit with display and DSP

Table 3 Headsets

Type Name

Wired

WH-203 Stereo headset

Wireless

BH-606 Bluetooth mono headset

BH-103 Bluetooth stereo headset

Table 4 Cables

Type Name

CA-101 Micro USB cable

 Technical specifications

General specifications

Unit Dimension (mm) Weight (g) Volume (cc)

RM-470 transceiver with
BL-6Q 960 mAh Li-Ion
battery pack

109.8 x 45.0 x 11.1 116 46.5

Main RF characteristics for GSM850/900/1800/1900 and WCDMA band I, II and VIII phones

Parameter Unit

Cellular system GSM850, EGSM900, GSM1800/1900, WCDMA I (2100), WCDMA II (1900)
and WCDMA VIII (900)

Rx frequency band GSM850: 869 - 894 MHz

EGSM900: 925 - 960 MHz

GSM1800: 1805 - 1880 MHz

GSM1900: 1930 - 1990 MHz

WCDMA I (2100): 2110 - 2170 MHz

WCDMA II (1900): 1930 - 1990

WCDMA VIII (900): 925- 960 MHz

RM-470
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Parameter Unit

Tx frequency band GSM850: 824 - 849 MHz

EGSM900: 880 - 915 MHz

GSM1800: 1710 - 1785 MHz

GSM1900: 1850 - 1910 MHz

WCDMA I (2100): 1920 - 1980 MHz

WCDMA II (1900): 1850 - 1910

WCDMA VIII (900): 880 - 915 MHz

Output power GSM850: +5 ...+33dBm/3.2mW ... 2W

GSM900: +5 … +33dBm/3.2mW … 2W

GSM1800: +0 … +30dBm/1.0mW … 1W

GSM1900: +0 … +30dBm/1.0mW … 1W

WCDMA I (2100): -50 ... +21 dBm/0.01μW ... 251.2mW

WCDMA II (1900): -50 ... +21 dBm/0.01μW ... 251.2mW

WCDMA VIII (900): -50 ... +21 dBm/0.01μW ... 251.2mW

Number of RF channels GSM850: 124

GSM900: 174

GSM1800: 374

GSM1900: 299

WCDMA I (2100): 277

WCDMA II (1900): 289

WCDMA VIII (900): 152

Channel spacing 200 kHz

Number of Tx power levels GSM850: 15

GSM900: 15

GSM1800: 16

GSM1900: 16

WCDMA I (2100): 75

WCDMA II (1900): 75

WCDMA VIII (900): 75

Battery endurance

Battery Talk time Standby time

BL-6Q 960 mAh Li-ion GSM: up to 5 h

WCDMA: up to 4 h

GSM: up to 416 h

WCDMA: up to 480 h

RM-470
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Note: Variation in operation times will occur depending on SIM card, network settings and usage.
Talk time is increased by up to 30% if half rate is active, and reduced by 5% if enhanced full rate is
active.

Environmental conditions

Environmental
condition

Ambient temperature Notes

Normal operation -15 oC ... +55 oC Specifications fulfilled

Reduced performance 55 oC ... +70 oC Operational only for short periods

Intermittent or no
operation

-40 oC ... -15 oC and +70 oC ... +85oC Operation not guaranteed but an
attempt to operate will not damage
the phone

No operation or
storage

<-40 oC and >+85 oC No storage. An attempt to operate
may cause permanent damage

Charging allowed -15 oC ... +55 oC

Long term storage
conditions

0 oC ... +85 oC

Humidity and water
resistance

Relative humidity range is 5 to 95%.

Condensed or dripping water may
cause intermittent malfunctions.

Protection against dripping water
has to be implemented in (enclosure)
mechanics.

Continuous dampness will cause
permanent damage to the module.
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 Service devices

Product specific devices
The table below gives a short overview of service devices that can be used for testing, error analysis, and
repair of product RM-470. For the correct use of the service devices, and the best effort of workbench setup,
please refer to various concepts.

FS-98 Flash adapter

• FS-98 is equipped with a clip interlock system

• provides standardised interface towards Control Unit

• provides RF connection using coupler

• multiplexing between USB and FBUS media, controlled by VUSB

RM-470
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MJ-204 Module jig

MJ-204 is meant for component level troubleshooting.

The jig includes an RF interface for GSM, WCDMA and Bluetooth. In
addition, it has the following features:

• Provides mechanical interface with the engine module

• Provides galvanic connection to all needed test pads in module

• Multiplexing between USB and FBUS media, controlled by Vusb

• MMC interface

• Duplicated SIM connector

• Connector for control unit

• Access for AV- and USB connectors

• Frequency Attenuation. (dB)

GSM850 TX -43.3

GSM850 RX -39.5

GSM900 TX -37.2

GSM900 RX -31.8

GSM1800 TX -34.0

GSM1800 RX -29.2

GSM1900 TX -28.3

GSM1900 RX -27.0

WCDMA band I TX -27.0

WCDMA band I RX -23.8

WCDMA band II TX -28.3

WCDMA band II RX -27.0

WCDMA band VIII TX -37.2

WCDMA band VIII RX -31.8

RM-470
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SA-106 RF coupler

SA-106 is an RF coupler for WCDMA and GSM RF testing. It is used
together with SS-62.

The following table shows attenuations from the antenna pads of the
mobile terminal to the SMA connectors of SA-106:

• Frequency Attenuation. (dB)

GSM850 TX Low:-10.4 Mid:-10.0 High:-10.0

GSM850 RX Low:-9.0 Mid:-8.5 High:-8.5

GSM900 TX Low:-8.5 Mid:-8.5 High:-8.5

GSM900 RX Low:-8.5 Mid:-9.1 High:-10.0

GSM1800 TX Low:-23.7 Mid:-20.0 High:-18.4

GSM1800 RX Low:-18.0 Mid:-17.2 High:-16.7

GSM1900 TX Low:-17.6 Mid:-16.7 High:-16.1

GSM1900 RX Low:-15.8 Mid:-15.1 High:-14.3

WCDMA band I TX Low:-15.9 Mid:-15.3 High:-14.7

WCDMA band I RX Low:-12.3 Mid:-12.2 High:-12.6

WCDMA band II TX Low:-17.5 Mid:-16.7 High:-16.1

WCDMA band II RX Low:-15.8 Mid:-15.1 High:-14.3

WCDMA band VIII TX Low:-8.5 Mid:-8.5 High:-9.2

WCDMA band VIII RX Low:-9.0 Mid:-9.0 High:-9.0

SA-131 GPS RF coupler

SA-131 is a RF coupler for GPS testing. It is used together with SS-62.

For more information on how to use the SA-131 with RM-470, see
Using SA-131 GPS RF coupler with RM-470 (page 2–7).

SS-209 Camera removal tool

Using SA-131 GPS RF coupler with RM-470
Use the following basic SA-131 setup for RM-470:

• 1575.520152 MHz

• -110 dbm

• 20 db fixed RF attenuator

RM-470
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• 22 db product specific RF attenuation

And use the following settings for the SA-131:

• Base setting: 3

• Sledge setting: 2

• Frame setting: A2

• Coupler setting: A2

• Direction: Down

Figure 2 Using SA-131 with RM-470

General devices
The table below gives a short overview of service devices that can be used for testing, error analysis, and
repair of product RM-470. For the correct use of the service devices, and the best effort of workbench setup,
please refer to various concepts.
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CU-4 Control unit

CU-4 is a general service tool used with a module jig and/or a flash
adapter. It requires an external 12 V power supply.

The unit has the following features:

• software controlled via USB

• EM calibration function

• Forwards FBUS/Flashbus traffic to/from terminal

• Forwards USB traffic to/from terminal

• software controlled BSI values

• regulated VBATT voltage

• 2 x USB2.0 connector (Hub)

• FBUS and USB connections supported

When using CU-4, note the special order of connecting cables and
other service equipment:

Instructions
1 Connect a service tool (jig, flash adapter) to CU-4.

2 Connect CU-4 to your PC with a USB cable.

3 Connect supply voltage (12 V)

4 Connect an FBUS cable (if necessary).

5 Start Phoenix service software.

Note: Phoenix enables CU-4 regulators via USB when it is
started.

Reconnecting the power supply requires a Phoenix restart.

RM-470
Service Devices and Service Concepts

Issue 1 COMPANY CONFIDENTIAL Page 2 –9
Copyright © 2009 Nokia. All rights reserved.



FLS-5 Flash device

FLS-5 is a dongle and flash device incorporated into one package,
developed specifically for POS use.

Note: FLS-5 can be used as an alternative to PKD-1.

RM-470
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FPS-21 Flash prommer

FPS-21 sales package:

• FPS-21 prommer

• AC-35 power supply

• CA-31D USB cable

FPS-21 interfaces:

Front
• Service cable connector

Provides Flashbus, USB and VBAT connections to a mobile device.

• SmartCard socket

A SmartCard is needed to allow DCT-4 generation mobile device
programming.

Rear
• DC power input

For connecting the external power supply (AC-35).

• Two USB A type ports (USB1/USB3)

Can be used, for example, for connecting external storage memory
devices or mobile devices

• One USB B type device connector (USB2)

For connecting a PC.

• Phone connector

Service cable connection for connecting Flashbus/FLA.

• Ethernet RJ45 type socket (LAN)

For connecting the FPS-21 to LAN.

Inside
• Four SD card memory slots

For internal storage memory.

Note: In order to access the SD memory card slots inside
FPS-21, the prommer needs to be opened by removing the
front panel, rear panel and heatsink from the prommer body.

Note: FPS-10 can be used for flashing instead of FPS-21 if
necessary.

PK-1 Software protection
key

PK-1 is a hardware protection key with a USB interface. It has the same
functionality as the PKD-1 series dongle.

PK-1 is meant for use with a PC that does not have a series interface.

To use this USB dongle for security service functions please register
the dongle in the same way as the PKD-1 series dongle.
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PKD-1 SW security device

SW security device is a piece of hardware enabling the use of the
service software when connected to the parallel (LPT) port of the PC.

Without the device, it is not possible to use the service software.

Printer or any such device can be connected to the PC through the
device if needed.

RJ-230 Soldering jig

RJ-230 is a soldering jig used for soldering and as a rework jig for the
engine module.

SB-6 Bluetooth test and
interface box (sales
package)

The SB-6 test box is a generic service device used to perform Bluetooth
bit error rate (BER) testing, and establishing cordless FBUS connection
via Bluetooth. An ACP-8x charger is needed for BER testing and an
AXS-4 cable in case of cordless interface usage testing .

Sales package includes:

• SB-6 test box

• Installation and warranty information

SRT-6 Opening tool

SRT-6 is used to open phone covers.

Note: The SRT-6 is included in the Nokia Standard Toolkit.

SS-46 Interface adapter

SS-46 acts as an interface adapter between the flash adapter and
FPS-20/FPS-21.
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SS-62 Generic flash adapter
base for BB5

• generic base for flash adapters and couplers

• SS-62 equipped with a clip interlock system

• provides standardised interface towards Control Unit

• provides RF connection using galvanic connector or coupler

• multiplexing between USB and FBUS media, controlled by VUSB

SX-4 Smart card

SX-4 is a BB5 security device used to protect critical features in tuning
and testing.

SX-4 is also needed together with FPS-20/FPS-21 when DCT-4 phones
are flashed.

Cables
The table below gives a short overview of service devices that can be used for testing, error analysis, and
repair of product RM-470. For the correct use of the service devices, and the best effort of workbench setup,
please refer to various concepts.

CA-101 Micro USB cable

The CA-101 is a USB-to-microUSB data cable that allows connections
between the PC and the phone.
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CA-31D USB cable

The CA-31D USB cable is used to connect FPS-20/FPS-21 to a PC. It is
included in the FPS-20/FPS-21 sales packages.

CA-58RS RF tuning cable

Product-specific adapter cable for RF tuning.

• Table 5 Attenuation values

Band Attenuation Rx/Tx

GSM850/900 0.2...0.3 dB

GSM1800/1900 0.3...0.4 dB

WCDMA/WLAN 0.4...0.6 dB

CA-89DS Cable

Provides VBAT and Flashbus connections to mobile device
programming adapters.
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DAU-9S MBUS cable

The MBUS cable DAU-9S has a modular connector and is used, for
example, between the PC's serial port and module jigs, flash adapters
or docking station adapters.

Note: Docking station adapters valid for DCT4 products.

PCS-1 Power cable

The PCS-1 power cable (DC) is used with a docking station, a module
jig or a control unit to supply a controlled voltage.

XRS-6 RF cable

The RF cable is used to connect, for example, a module repair jig to
the RF measurement equipment.

SMA to N-Connector approximately 610 mm.

Attenuation for:

• GSM850/900: 0.3+-0.1 dB

• GSM1800/1900: 0.5+-0.1 dB

• WCDMA/WLAN: 0.6+-0.1dB
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 Service concepts

POS (Point of Sale) flash concept

Figure 3 POS flash concept

Type Description

Product specific tools

BL-6Q Battery

Other tools

FLS-5 POS flash dongle

PC with Phoenix service software

Cables

CA-101 Micro USB cable
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Flash concept with FPS-21

Figure 4 Basic flash concept with FPS-21

Type Description

Product specific devices

FS-98 Flash adapter

Other devices

FPS-21 Flash prommer box

AC-35 Power supply

PK-1/PKD-1 SW security device

SS-46 Interface adapter

PC with Phoenix service software

Cables

CA-89DS Service cable

USB cable
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CU-4 flash concept with FPS-21

Figure 5 CU-4 flash concept with FPS-21

Type Description

Product specific devices

FS-98 Flash adapter

Other devices

CU-4 Control unit

FPS-21 Flash prommer box

AC-35 Power supply

PK-1/PKD-1 SW security device

SS-62 Flash adapter base

SX-4 Smart card (for DCT-4 generation mobile device programming)

PC with Phoenix service software

Cables

PCS-1 Power cable

CA-89DS Service cable

Standard USB cable

RM-470
Service Devices and Service Concepts

Page 2 –18 COMPANY CONFIDENTIAL Issue 1
Copyright © 2009 Nokia. All rights reserved.



Type Description

USB cable

Module jig service concept

Figure 6 Module jig service concept

Type Description

Phone specific devices

MJ-204 Module jig

Other devices

CU-4 Control unit

FPS-21 Flash prommer box

PK-1/PKD-1 SW security device

SX-4 Smart card

PC with VPOS and Phoenix service software

Measurement equipment

Cables

CA-89DS Service cable

PCS-1 DC power cable
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Type Description

XRS-6 RF cable

USB cable

GPIB control cable

RF testing concept with RF coupler

Figure 7 RF testing concept with RF coupler

Type Description

Product specific devices

FS-98 Flash adapter

SA-106 RF coupler

Other devices

CU-4 Control unit

SX-4 Smart card

FPS-21 Flash prommer box

PK-1/PKD-1 SW security device

SS-62 Flash adapter base

Measurement equipment

PC with Phoenix service software
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Type Description

Cables

CA-89DS Service cable

PCS-1 Power cable

XRS-6 RF cable

GPIB control cable

USB cable

Service concept for RF testing and RF/BB tuning

Figure 8 Service concept for RF testing and RF/BB tuning

Type Description

Product specific devices

MJ-204 Module jig

Other devices

CU-4 Control unit

PK-1/PKD-1 SW security device

SX-4 Smart card

Measurement equipment

RM-470
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Type Description

Smart card reader

PC with Phoenix service software

Cables

DAU-9S MBUS cable

PCS-1 DC power cable

XRS-6 RF cable

GPIB control cable

USB cable

GPS testing concept with GPS RF coupler

Figure 9 RF testing concept with RF coupler

Type Description

Product specific devices

FS-98 Flash adapter

SA-131 GPS RF coupler

Other devices

CU-4 Control unit

SX-4 Smart card

RM-470
Service Devices and Service Concepts

Page 2 –22 COMPANY CONFIDENTIAL Issue 1
Copyright © 2009 Nokia. All rights reserved.



Type Description

JXS-1 RF shield box

PKD-1/PK-1 SW security device

SS-62 Flash adapter base

Smart card reader

Measurement equipment

PC with Phoenix service software

Cables

CA-58RS RF service cable (product-specific adapter cable)

PCS-1 Power cable

DAU-9S MBUS cable

XRS-6 RF cable

20dB attenuator

Interface cable

USB cable

Bluetooth testing concept with SB-6

Figure 10 Service concept for RF testing and RF/BB tuning

Type Description

Product specific devices
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Type Description

FS-98 Flash adapter

Other devices

CU-4 Control unit

SS-62 Flash adapter base

PK-1 SW security device

SX-4 Smart card

SB-6 Bluetooth test and interface box

Smart card reader

PC with Phoenix service software

Cables

DAU-9S MBUS cable

PCS-1 DC power cable

USB cable
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 Baseband self tests in Phoenix

Context
Always start the troubleshooting procedure by running the Phoenix self tests. If a test fails, please follow the
diagram below.

If the phone is dead and you cannot perform the self tests, go to Dead or jammed device troubleshooting.

RM-470
BB Troubleshooting and Manual Tuning Guide

Issue 1 COMPANY CONFIDENTIAL Page 3 –5
Copyright © 2009 Nokia. All rights reserved.



Troubleshooting flow
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 Power and charging troubleshooting

Dead or jammed device troubleshooting

Troubleshooting flow - Page 1 of 2
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Troubleshooting flow - Page 2 of 2
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Power key troubleshooting

Troubleshooting flow
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General voltage checking troubleshooting

Troubleshooting flow - Page 1 of 2
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Troubleshooting flow - Page 2 of 2
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General power checking
Check the following voltages:

Signal
Rename

Regulator Sleep Idle Nominal
voltage

Main user Notes

VIO Pearl/Gazoo ON ON 1.8 Memory, I/Os,
Display

VBACK Pearl/Gazoo ON ON 2.5 Back-up
battery

VSIM1 Pearl/Gazoo ON ON 1.8/3.0 SIM card

VAUX1 Pearl/Gazoo ON ON 2.8 TV-OUT, 3DFS,
MR, Display

VAUX2 Pearl/Gazoo OFF OFF 2.5 ALS

VANA Pearl/Gazoo ON ON 2.5 Audio

VR1 Pearl/Gazoo OFF ON 2.5 Crystal
oscillators

VRFC Pearl/Gazoo OFF ON 1.8 RAPU
converters

VRCP1 Pearl/Gazoo 4.75 To RF parts

VREF Pearl/Gazoo ON ON 1.25 RF reference

VCORE Pearl/Gazoo ON ON 1.2 RAPU digital Can change due
to RAPU version
& SW

VOUT Pearl/Gazoo OFF OFF 2.5 Video switch

VCAM_2V8 N1421 OFF OFF 2.8 Camera Disabled in
sleep

VCAM_1V8 N1420 OFF OFF 1.800 Camera Disabled in
sleep

VMEM Pearl/Gazoo OFF OFF 2.9 microSD Disabled in
sleep
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Charging troubleshooting

Troubleshooting flow
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USB charging troubleshooting

Context
For instructions regarding USB charging troubleshooting, see section USB charging troubleshooting
(page 3–25).
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Battery current measuring fault troubleshooting

Troubleshooting flow
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Clocking troubleshooting

Troubleshooting flow
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 Interface troubleshooting

Flash programming fault troubleshooting

Troubleshooting flow - Page 1 of 2
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Troubleshooting flow - Page 2 of 2

Figure 11 Flashing pic 1. Take single trig measurement for the rise of the BSI signal
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Figure 12 Flashing pic 2. Take single trig measurement for the rise of the BSI signal
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SIM card troubleshooting

Troubleshooting flow
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MicroSD card troubleshooting

Troubleshooting flow
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USB troubleshooting

USB data interface troubleshooting

Troubleshooting flow - Page 1 of 2
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Troubleshooting flow - Page 2 of 2
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USB charging troubleshooting

Troubleshooting flow
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 User interface troubleshooting

Keyboard and side keys troubleshooting

Context
Possible failure mode in the keyboard module:

• One or more keys are stuck, so that the key does not react when a keydome or a side key is pressed. This
kind of failure is caused by mechanical reasons (dirt, rust, mechanical damage, etc.)

If the failure mode is not clear, start with the Keyboard test in Phoenix.

In this phone the keyboard is connected to RAPU via an I/O Expander. RAPU controls the I/O Expander by the
I2C bus.

Troubleshooting flow
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Navi key troubleshooting

Troubleshooting flow
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Keyboard LEDs and Navi key LEDs troubleshooting

Troubleshooting flow

Accelerometer self test troubleshooting

Context
The accelerometer is sensitive to all vibrations and movements (including those made by IHF and Vibra).
Make sure before starting the troubleshooting that there are no vibrations or movements which could have
an impact on the analysis.

The three different axes for the accelerometer are illustrated in the picture below.
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Figure 13 Accelerometer axes
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Troubleshooting flow
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Symptoms and diagnosis

Table 6 Nominal x, y, z readout

Position Nominal readout X Nominal readout Y Nominal readout Z

Phone lying flat on
table. Display up.

0.0 0.0 1.0

Phone lying flat on
table. Display
down.

0.0 0.0 -1.0

Holding the phone
horizontal

0.0 1.0 0.0

Holding the phone
right side down

-1.0 0.0 0.0

The impact test is done with the phone in four different positions to test all axes. The table presents the nominal value readout value
for x, y and z axis in the different phone positions. Tolerance +/- 0.9

Table 7 Nominal voltages

Supply Measure on Nominal voltage

VAUX2 C6575

C6576

2.5 V

VIO C6577 1.8 V

Display module troubleshooting

General instructions for display troubleshooting

Context
• The display is in a normal mode when the phone is in active use.

• The operating modes of the display can be controlled with the help of Phoenix.

Table 8 Display module troubleshooting cases

Display blank There is no image on the display. The display looks
the same when the phone is on as it does when the
phone is off. The backlight can be on in some cases.

Image on the display not correct Image on the display can be corrupted or a part of
the image can be missing.

• If a part of the image is missing, change the
display module.

• If the image is otherwise corrupted, follow the
display fault troubleshooting flowchart.
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Backlight dim or not working at all Backlight LED components are inside the display
module. Backlight failure can also be in the
connector or in the backlight power source in the
main engine of the phone.

This means that in case the display is working
(image OK), the backlight is faulty.

Visual defects (pixel) Pixel defects can be checked by controlling the
display with Phoenix. Use both colours, black and
white, on a full screen.

The display may have some random pixel defects
that are acceptable for this type of display. The
criteria when pixel defects are regarded as a display
failure, resulting in a replacement of the display, are
presented the following table.

Table 9 Pixel defects

Item White dot defect Black dot
defect

Total

1 Defect counts R G B White Dot
Total

1 1

1 1 1 1

2 Combined
defect counts

Not allowed.

Two single dot defects that are within 5 mm of each other should be
interpreted as combined dot defect.

Steps
1. Verify with a working display that the fault is not on the display module itself.

The display module cannot be repaired.

2. Check that the cellular engine is working normally.

i To check the functionality, connect the phone to a docking station.

ii StartPhoenix service software.

iii Read the phone information to check that also the application engine is functioning normally (you
should be able to read the APE ID).

3. Proceed to the display fault troubleshooting flowchart.

Use the Display Test tool in Phoenix to find the detailed fault mode.
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Display fault troubleshooting

Troubleshooting flow
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Display backlight troubleshooting

Troubleshooting flow
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Ambient light sensor (ALS)

ALS troubleshooting

Troubleshooting flow
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ALS functionality check

Steps
1. Connect phone to Phoenix and set the phone (e.g. on the table) so that the amount of ambient light seen

by ALS is as stable as possible.

2. Start Phoenix

3. Choose File -> Scan product

4. Choose Testing -> Display Test

5. Open the Lights tab, check Ambient Light Sensor check box, click Read, cover the sensor and click Read
again. When covered, Luminance reading should be less than after clicking Read without covering the
sensor.

6. If component doesn’t give any reading or reading doesn’t change when sensor is/is not covered, replace
the part.

Note: After replacing the ALS. If calibration values of the new sensor are lost or for some other
reason, ALS re-tuning is required (see instructions later in this document).

When doing the ALS calibration procedure, it is required to have a reference phone, which includes
calibrated ALS. ALS re-tuning instructions show why the reference phone is needed.

ALS retuning

Steps
1. Connect reference phone to Phoenix and set the phone (e.g. on the table) so that the amount of ambient

light seen by ALS is as stabile as possible.

2. Start Phoenix.

3. Choose File→Scan Product.
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4. Choose Tuning -> Ambient Light Sensor Calibration. You should see the following window

5. Read AD-count values for Channel 0 and Channel 1 by click Read button and write them down.

6. Repeat 1-5 for the phone to be calibrated and make sure the phone to be calibrated is located in the
same place as reference phone was when luminance reading was taken.

7. Calculate co-efficient from reference phone and phone to be calibrated AD-count values by division: Co-
efficient = AD-count(reference phone) / AD-count(phone to be calibrated), write down the calculated co-
efficient values.

8. -> Iterate by changing Channel 0 and Channel 1 (reference level) values (remove cross from ‘Use default
values only’). After writing some value to Channel 0 and Channel 1 (reference value), calibrate button
must be pressed. Stop iterating when Co-efficient is equal to Co-efficient calculated in bullet 7. Note that
decimal numbers should be used in the iteration in order to achieve enough precision (e.g. 200.2455)

9. After having same Co-efficient value in “Co-efficient” textbox as the calculated value, make sure that
ambient light values (read using Testing → Display Test → “Luminance” textbox) are almost the same
in reference phone and calibrated phone. Remember that illuminance readings for reference and
calibrated phones must be done in the same ambient light conditions. If illuminance values differs a lot
(difference max. +- 10%), repeat whole ALS re-tuning procedure.

10. To end the calibration, click Close.
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 GPS troubleshooting

GPS antenna
The GPS antenna is covering the GPS band. The GPS antenna consists of an antenna flex assembled directly
onto the A-cover and connects with a pogo pin onto a pad on the top flex.

Figure 14 GPS antenna location

GPS layout and basic test points

Figure 15 GPS layout and basic test points

VBat, ASIC internal LDO voltages, and clocks are available as shown in figure above.
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GPS settings for Phoenix

GPS control

Context
Use the following to test GPS using Phoenix.

Steps
1. Start Phoenix service software.

2. From the File menu, select Scan Product and check that the correct product version is displayed.

3. From the Testing menu, select GPS Control. This opens up GPS Control dialogue box, as shown in the
figure below, and enables the GPS.

Figure 16 GPS Control dialog box

Select Receiver On to confirm the GPS is enabled and is in idle mode; at this point all clocks should be
present, GPS_En_Reset & SleepX should be high, and Vdd_Dig, Vcc_TCXO & Vcc_PLL/VCO will be present.

Receiver On turns on all RF sections of the ASIC and so all LDOs will be on. These checks are part of GPS
basic checks troubleshooting (page 3– 0 ).

GPS Quick Test window
The GPS Quick Test window has all the necessary functionality for GPS troubleshooting. Ensure the test setup
is correct and click Start Test. (Select Help for further information).

This test will perform three tests in one; Self Test, Oscillator Test and CW Test, and will provide a Pass/Fail
response. The GPS Quick Test window also contains a Receiver On button. These checks are part of GPS failure
troubleshooting (page 3–41).
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Figure 17 GPS Quick Test window for GPS troubleshooting

GPS RF test points
Checking for a connection between these two test points will confirm that the antenna is working correctly,
as well as performing a radiated CW test.

J6280 = GPS Ant

J7451 = GPS Ant Gnd

In order to probe GPS RF test points, inject 1575.52 MHz tone @ -110dBm at the GPS antenna test connector
and select Receiver On, then probe the GPS RF test points as shown in figure "GPS RF probe points". Compare
RF levels with a known reference phone.
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Figure 18 GPS RF probe points

GPS failure troubleshooting

Context
GPS troubleshooting is broken down into two parts: general GPS failure troubleshooting and GPS basic checks
troubleshooting. The GPS failure troubleshooting flow can be followed and, where applicable, will feed into
the GPS basic checks troubleshooting flow.
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Troubleshooting flow
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GPS basic checks troubleshooting

Troubleshooting flow
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 Camera module troubleshooting

Introduction to camera troubleshooting
Bad conditions often cause bad pictures. Therefore, the camera operation has to be checked in constant
conditions or by using a second, known-to-be-good Nokia device as reference. Image quality is hard to
measure quantitatively, and the difference between a good and a bad picture can be small. Some training
or experience may be needed to detect what is actually wrong.

When checking for possible errors in camera functionality, knowing what error is suspected significantly
helps the testing by narrowing down the amount of test cases. The following types of image quality problems
are common:

• Dust (black spots)

• Lack of sharpness

• Bit errors

Camera troubleshooting

Taking and evaluating test pictures
When taking a test picture, remember the following:

• Avoid bright fluorescent light, 50/60Hz electrical network or high artificial illumination levels

• If the phone is hot, let it rest for a while before taking the picture

• Make sure the optical system is clean

• Use highest possible resolution

• Make sure the light is sufficient (bright office lightning)

• Do not take the picture towards a light source

• Hold the phone as still as possible when taking the picture

• If camera has auto focus: Pictures should be taken both at infinity ~>2m and at macro distance ~10-15 cm
in order to verify auto focus functionality

When evaluating a test picture, remember the following:

• The center of the picture is sharper than the edges

• The image may be blurred, though it does not show in the viewfinder

• Analyse the picture from your PC monitor, full colour setting is recommended

• If possible, compare with a picture of the same motive taken with a similar Nokia device

• If camera has auto focus: Remember that the white focussing frame which appears when the camera
button is pressed halfway down, must turn green for auto focus lock. If the frame turns red, the camera
is not focussed!
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Camera troubleshooting

Troubleshooting flow
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Camera baseband troubleshooting

Troubleshooting flow
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Camera no recognizable viewfinder image troubleshooting

Troubleshooting flow
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Camera bad image quality troubleshooting

Troubleshooting flow
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Camera flash troubleshooting

Context
Note: Before checking flash functionality, make sure that the camera is working ok.

Troubleshooting flow
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 Audio troubleshooting

Audio troubleshooting test instructions
Differential external earpiece and internal earpiece outputs can be measured either with a single-ended or
a differential probe.

When measuring with a single-ended probe each output is measured against the ground.

Internal handsfree output is measured using a current probe, if a special low-pass filter designed for
measuring a digital amplifier is not available. Note also that when using a current probe, the input signal
frequency must be set to 2kHz.

The input signal for each loop test can be either single-ended or differential.

Required equipment
The following equipment is needed for the tests:

• Oscilloscope

• Function generator (sine waveform)

• Phoenix service software

• Battery voltage 3.7V

Test procedure
Audio can be tested using the Phoenix audio routings option. These different audio loop paths can be
activated:

• Mic2P to Internal earpiece

• Mic2P microphone to Internal handsfree speaker

Each audio loop sets routing from the specified input to the specified output enabling a quick in-out test.
Loop path gains are fixed and they cannot be changed using Phoenix. Correct pins and signals for each test
are presented in a table in the following section.

Phoenix audio loop tests and test results
The results presented in this table apply when no accessory is connected and battery voltage is set to 3.7V.

Earpiece, internal microphone and speaker are in place during measurement. Applying a headset accessory
during measurement causes a significant drop in measured quantities.

The gain values presented in the table apply for a differential output vs. single-ended/differential input.

Loop test Input
terminal

Output
terminal

Path
gain [dB]

(fixed)

Input
voltage
[mVp-p]

Differential
output
voltage
[mVp-p]

Output
DC level

[V]

Output
current

[mA]

External Mic to
Internal
Earpiece

testpad
J2101

EarP and
EarN

~9 100 288 NA NA

External Mic to
Internal
handsfree

testpad
J2101

B2170 pads ~16 100 600 NA NA
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Measurement data

If a special low-pass filter designed for measuring digital amplifiers is unavailable, the measurement must be performed with a
current probe and the input signal frequency must be 2kHz.

Figure 19 Differential output waveform of the Ext_in_IHF_out out loop measurement when speaker is connected.
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Internal earpiece troubleshooting

Troubleshooting flow
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Internal microphone troubleshooting

Troubleshooting flow
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Internal handsfree (IHF) troubleshooting

Troubleshooting flow

Acoustics troubleshooting

Introduction to acoustics troubleshooting
Acoustics design ensures that the sound is detected correctly with a microphone and properly radiated to
the outside of the device by the speaker. The acoustics of the phone include three basic systems: earpiece,
integrated handsfree (IHF) and dual microphone (for noise cancelling).

The sound reproduced from the earpiece eradiates through a single hole on the front cover (A-cover). The
sound reproduced from the IHF speaker radiates from the sound hole located on the back side on the top
part of the phone. The inlets for the 2 microphones are found in the bottom and next to the capture key,
respectively.
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For a correct functionality of the phone, all sound holes must be always open. When the phone is used, care
must be taken not to close any of those holes with a hand or fingers. The phone should be dry and clean,
and no objects must be located in such a way that they close any of the holes.

Earpiece troubleshooting

Troubleshooting flow
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IHF troubleshooting

Troubleshooting flow

RM-470
BB Troubleshooting and Manual Tuning Guide

Page 3 –56 COMPANY CONFIDENTIAL Issue 1
Copyright © 2009 Nokia. All rights reserved.



Microphone troubleshooting

Troubleshooting flow
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Vibra troubleshooting

Troubleshooting flow
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 Bluetooth troubleshooting

Troubleshooting flow
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 Baseband manual tuning guide

Certificate restoring for BB5 products

Context
This procedure is performed when the device certificate is corrupted for some reason.

All tunings (RF & Baseband, UI) must be done after performing the certificate restoring procedure.

The procedure for certificate restoring is the following:

• Flash the phone with the latest available software using FPS-20 or FPS-21.

Note: USB flashing does not work for a dead BB5 phone.

• Create a request file.

• Send the file to Nokia by e-mail. Use the following addresses depending on your location:

• APAC: sydney.service@nokia.com

• CHINA: repair.ams@nokia.com

• E&A: salo.repair@nokia.com

• AMERICAS: fls1.usa@nokia.com

• When you receive a reply from Nokia, carry out certificate restoring.

• Tune the phone completely.

Note: SX-4 smart card is needed.

• If the phone resets after certificate restoring, reflash the phone again.

Required equipment and setup:

• Phoenix service software v 2008.34/38 or newer.

• The latest phone model specific Phoenix data package.

• PKD-1 dongle

• SX-4 smart card (Enables BB5 testing and tuning features)

• Activated FPS-20 flash prommer OR FPS-21 flash prommer

• Flash update package 08.30.012 or newer for FPS-20 or FPS-21 flash prommers

• CU-4 control unit

• USB cable from PC USB Port to CU-4 control unit

• Phone model specific adapter for CU-4 control unit

• PCS-1 cable to power CU-4 from external power supply

• XCS-4 modular cable between flash prommer and CU-4

Note: CU-4 must be supplied with +12 V from an external power supply in all steps of certificate
restoring.

Steps
1. Program the phone software.

i Start Phoenix and login. Make sure the connection has been managed correctly for FPS-20 or FPS-21.

ii Update the phone MCU software to the latest available version.

If the new flash is empty and the phone cannot communicate with Phoenix, reflash the phone.
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iii Choose the product manually from File→Open Product , and click OK.

Wait for the phone type designator (e.g. “RM-1” ) to be displayed in the status bar.

iv Go to Flashing→SW Update  and wait until Phoenix reads the product data as shown in the following
picture.

Product is automatically set according to the phone support module which was opened manually,
but the flash files cannot be found because the correct data cannot be read from the phone
automatically.

Code must be chosen manually, it determines the correct flash files to be used. Please choose the
correct product code (can be seen in the phone type label) from the dropdown list.

Flash Type must be set to Phone as Manufactured.

v To continue, click Start.

Progress bars and messages on the screen show actions during phone programming, please wait.
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Programming is completed when Flashing Completed message is displayed.

The product type designator and MCU SW version are displayed in the status bar.

vi Close the SW Update window and then choose File→Close Product .

2. Create a Request file.

For this procedure, you must supply +12 V to CU-4 from an external power supply.

i To connect the phone with Phoenix, choose File→Scan Product .

ii Choose Tools→Certificate Restore .

iii To choose a location for the request file, click Browse.
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iv Name the file so that you can easily identify it, and click Open.

The name of the file and its location are shown.

v To create the Request file, click Start.

vi When the file for certificate restore has been created, send it to Nokia as an e-mail attachment.

3. Restore certificate.

For this procedure, you must supply +12 V to CU-4 from an external power supply.

i Save the reply file sent by Nokia to your computer.

ii Start Phoenix service software.

iii Choose File→Scan Product .
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iv From the Tools menu, choose Certificate Restore and select Process a response file in the Action
pane.

v To choose the location where response file is saved, click Browse.

vi Click Open.

The name of the file and the path where it is located are shown.

vii To write the file to phone, click Start.

Next actions
After a successful rewrite, you must retune the phone completely by using Phoenix tuning functions.

Important: Perform all tunings: RF, BB, and UI.
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Energy management calibration

Prerequisites
Energy Management (EM) calibration is performed to calibrate the setting (gain and offset) of AD converters
in several channels (that is, battery voltage, BSI, battery current) to get an accurate AD conversion result.

Hardware setup:

• An external power supply is needed.

• Supply 12V DC from an external power supply to CU-4 to power up the phone.

• The phone must be connected to a CU-4 control unit with a product-specific flash adapter.

Steps
1. Place the phone to the docking station adapter (CU-4 is connected to the adapter).

2. Start Phoenix service software.

3. Choose File→ Scan Product.

4. Choose Tuning→Energy Management Calibration.

5. To show the current values in the phone memory, click Read, and check that communication between
the phone and CU-4 works.

6. Check that the CU-4 used check box is checked.

7. Select the item(s) to be calibrated.

Note: ADC calibration has to be performed before other item(s). However, if all calibrations are
selected at the same time, there is no need to perform the ADC calibration first.

8. Click Calibrate.

The calibration of the selected item(s) is carried out automatically.

The candidates for the new calibration values are shown in the Calculated values column. If the new
calibration values seem to be acceptable (please refer to the following "Calibration value limits" table),
click Write to store the new calibration values to the phone permanent memory.

Table 10 Calibration value limits

Parameter Min. Max.

ADC Offset -30 +40

ADC Gain 12000 14000

BSI Gain 1100 1350

VBAT Offset 2635 2755

VBAT Gain 14900 15900

VCHAR Gain N/A N/A

IBAT (ICal) Gain 7750 12250

9. Click Read, and confirm that the new calibration values are stored in the phone memory correctly. If the
values are not stored to the phone memory, click Write and/or repeat the procedure again.

10. To end the procedure, close the Energy Management Calibration window.
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 General RF troubleshooting

Introduction to RF troubleshooting

Most RF semiconductors are static discharge sensitive
ESD protection must be applied during repair (ground straps and ESD soldering irons).

Pre-baking
These parts are moisture sensitive and must be pre-baked prior to soldering:

• VAPAUS RFIC (N7500)

• TX FEM (N7520)

• WCDMA PA (N7540)

• Aura DC/DC converter (N7560)

Discrete components
In addition to the key components, there are a number of discrete components (resistors, inductors and
capacitors) for which troubleshooting is done mainly by visual inspection.

Capacitors: check for short circuits.

Resistors: check value with an ohm meter.

Note: In-circuit measurements should be evaluated carefully.

Measuring equipment
All measurements should be done using:

• Module jig MJ-204

• Flash adapter FS-98

• Control unit CU-4/Interface adapter SS-46

• An oscilloscope for low frequency and DC measurements. Recommended probe: 10:1, 10MOhm/8pF.

• A radio communication tester including RF generator and spectrum analyser, for example Rohde & Schwarz
CMU200. (Alternatively a spectrum analyser and a RF generator can be used. However, some tests in this
guide are not possible to perform if this solution is chosen).

Note: A mobile phone WCDMA transmitter should never be tested with full TX power (only if it is
possible to perform the measurement in a good RF-shielded room). Even low power WCDMA
transmitters may disturb nearby WCDMA networks and cause problems to 3G cellular phone
communication in a wide area.

Note: All measurements with an RF coupler should be performed in an RF-shielded environment
because nearby base stations can disturb sensitive receiver measurements. If there is no possibility
to use RF shielded environment, testing at frequencies of nearby base stations should be avoided.

Level of repair
The scope of this guideline is to verify functionality of the cellular RF block without removing RF shield.

Instructions for finding the faulty component are provided in some cases, but the whole RF block still needs
to be replaced even when a single component is faulty.
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RF key components

Figure 20 RF key components

 Auto tuning

Introduction to auto tuning
This phone can be tuned automatically.

Auto tune is designed to align the phone's RF part easier and faster. It performs calibrations, tunings and
measurements of RX and TX. The results are displayed and logged in a result file, if initiated.

Hardware set up
Hardware requirements for auto tuning:

• PC (Windows 2000/XP) with GPIB card

• PK-1/PDK-1 service dongle

• Power supply

• Product specific module jig

• Cables: RF cable XRS-6, USB cable, GBIP cable and MBUS cable DAU-9S

• Signal analyser (TX), signal generator (RX) and RF-splitter or one device including all.
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Figure 21 Auto tuning concept with CMU200

Auto tuning procedure

Prerequisites
Install the phone-specific data package, e.g. Nokia_firmware_RM_470_xxx_v1.00.exe.

The data package defines the phone-specific settings.

Steps
1. Make sure the phone (in the jig) is connected to the equipment. Else, some menus will not be shown in

Phoenix.

2. Go to loss settings by selecting Tuning (Alt_U)→SET LOSS  from the menu.

3. Set the loss between CMV200 and the phone. (Total loss = cable + jig)

4. Go to auto tuning by selecting Tuning (Alt_U)→Auto-tune (Alt_A)  from the menu.

5. Start auto tuning by clicking the Tune button.

 Self test troubleshooting

Phoenix self test troubleshooting

Context
Always start the troubleshooting procedure by running the Phoenix self tests. If a test fails, please follow the
diagram below.

If the phone is dead and you cannot perform the self tests, go to Dead or jammed device troubleshooting
(page 4–7) in chapter 3, Baseband troubleshooting and manual tuning guide.

Note: Self tests are recommended to be made when phone is in jig and a 50Ω load connected to
the RF connector. Otherwise power tests may fail depending on antenna load
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Troubleshooting flow
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 Receiver troubleshooting

Introduction to receiver (RX) troubleshooting
RX can be tested by making a phone call or in local mode. For the local mode testing, use Phoenix service
software.

The main RX troubleshooting measurement is RSSI reading. This test measures the signal strength of the
received signal. For GSM RSSI measurements, see section GSM RX chain activation for manual measurements/
GSM RSSI measurement (page 4–9) . For a similar test in WCDMA mode, see section WCDMA RSSI
measurement (page 4–12).

The RX path for GSM and WCDMA are using the same filters in some bands. Please refer to RM-470 RF
components reference (page 4–26) for details.

GSM RX chain activation for manual measurements/GSM RSSI measurement

Prerequisites
Make the following settings in signal generator and Phoenix service software:

Setting GSM850 GSM900 GSM1800 GSM1900

Phoenix Channel 190 37 700 661

Signal generator
to antenna
connector

881.46771MHz
(67.71kHz offset)
at -60dBm

942.46771MHz
(67.71kHz offset)
at -60dBm

1842.86771MHz
(67.71kHz offset)
at -60dBm

1960.06771MHz
(67.71kHz offset)
at -60dBm

Steps
1. Set the phone to local mode.

2. Activate RSSI reading in Phoenix by selecting Testing→GSM→RSSI reading .

Figure 22 Phoenix RSSI Reading window

Results
The reading should reflect the level of the signal generator (minus losses) ±5dB.

When varying the level in the range -30 to -102dBm the reading should then follow within ±5dB.
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GSM receiver troubleshooting flowchart

Troubleshooting flow
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WCDMA RX chain activation for manual measurement

Steps
1. In Phoenix, select Testing→WCDMA→Rx Control . The Phoenix Rx Control window opens.

Figure 23 Phoenix Rx Control window with sample settings (WCDMA band I)

2. Make settings for the band to be tested according to the following table:

Band to be tested Phoenix Channel Signal generator to antenna
connector

WCDMA I 10700 2141.0MHz

WCDMA II 9800 1961.0MHz

WCDMA VIII 3013 943.6MHz

3. Make the following general settings (the same values for all bands):

Setting Value

AGC Mode Algorithm

AFC Algorithm OFF

AFC DAC 1024

4. Click Start to activate the settings.

If the settings are changed later on (for example, change of channel) you have to click Stop and Start
again.
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Note: Clicking Stop also disables TX control if it was active.

WCDMA RSSI measurement

Prerequisites
WCDMA RX must be activated before RSSI can be measured. For instructions, please refer to WCDMA RX chain
activation for manual measurement (page 4–11).

Connect signal generator to RF connector and use appropriate frequency for each channel.

Steps
1. In Phoenix select Testing→WCDMA→RX Power measurement . The Rx Power Measurement window

opens.

Figure 24 Phoenix Rx Power Measurement window

2. In the RX Power measurement window, select:

• Mode: RSSI

• Continuous mode

3. Click Start to perform the measurement.

Note: WCDMA RSSI measurement is accurate only with WCDMA modulated signal.
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WCDMA receiver troubleshooting flowchart

Troubleshooting flow
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 Transmitter troubleshooting

Introduction to transmitter (TX) troubleshooting
Please note the following before performing transmitter tests:

• TX troubleshooting requires TX operation.

• Do not transmit on frequencies that are in use!

• The transmitter can be controlled in local mode for diagnostic purposes.

• The most useful Phoenix tool for GSM transmitter testing is “RF Control”; in WCDMA transmitter testing
the best tool is “TX Control”.

• Remember that re-tuning is not a fix! Phones are tuned correctly in production.

• The RX path for GSM and WCDMA are using the same filters in some bands. Please refer to RM-470 RF
components reference (page 4–26) for details.

Note: Never activate the GSM or WCDMA transmitter without a proper antenna load. Always connect
a 50Ω load to the RF connector (antenna, RF-measurement equipment or at least a 2W dummy load);
otherwise the GSM or WCDMA Power amplifier (PA) may be damaged.

GSM transmitter troubleshooting

Steps
1. Set the phone to local mode.

2. In Phoenix, select Testing→GSM→Rf Controls . The RF Controls window opens.

Figure 25 Phoenix RF Controls window

3. Make the following settings:
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Setting Value

Active Unit Tx

Rx/Tx Channel 37

Band GSM 900

AFC -28

Operation Mode Burst

Edge Off

Tx Data Type Random

Tx PA Mode High

Tx Power Level 5

4. Check the basic TX parameters, using a communication analyser (e.g. CMU200).

• Power

• Phase error

• Modulation

• Switching spectrum
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Figure 26 Typical readings

5. Change the power level in RF controls window and make sure the power reading follows accordingly.
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Next actions
You can troubleshoot the GSM transmitter for each GSM band separately, one band at a time. If you want to
troubleshoot GSM850, GSM1800 or GSM1900, change the band in the RF controls window and set the
communication analyser accordingly.
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GSM transmitter troubleshooting flowchart

Troubleshooting flow
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WCDMA transmitter troubleshooting

Steps
1. Set the phone to local mode.

2. In Phoenix, select Testing→WCDMA→Tx control . The Tx Control window opens.

Figure 27 Phoenix WCDMA Tx control window

3. Make settings for the band to be tested, according to the following table:

Band Channel

WCDMA I 9750

WCDMA II 9400

WCDMA VIII 2788

4. Make the following general settings (the same values for all bands). Note that Max power limit is not
checked by default.
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Setting Value

DPDCH enabled Checked

Max power limit Checked

Start Rx Checked

Start level 24

Step size 0

Step count 0

Sequency 0

Step duration 2550

Code class LONG

Code 16

DPDCH code 0

Weight 15

Code class 2

DPCCH code 0

Weight 8

Code class 2

Note: Use the Start level option to set the TX power level.

5. Click Send to enable the settings and activate TX.

If settings are changed (eg. new channel selected), you have to click RF Stop and Send again.

6. Check the basic TX parameters using a communication analyser (e.g. CMU200).
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Figure 28 Typical readings
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WCDMA transmitter troubleshooting flowchart

Troubleshooting flow
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 Troubleshooting with RF-shield removed

Introduction
The RF-shield should not be removed in order to replace single components on the RF block. This chapter
only assists in locating the faulty component for statistical purposes.

Voltage checking

Steps
1. Set up the main board in the module jig. The phone should be in local mode.

2. Check the following:

TP# Signal name Test point Voltage (all bands)

1 VCTCXO (G7500) supply C7501 2.5V

2 RFIC Vapaus (N7500) supply from DC/DC
converter

C7570 2.8V

3 TXFEM (N7520) supply from DC/DC
converter

C7521 1.3V-3.8V (only when transmitting and
depends on output power).

4 WCDMA PA (N7540) supply from DC/DC
converter

C7528 0.7V-3.1V (only when transmitting and
depends on output power). The value
will be 3.1V when settings as described
in the note below are used.

5 Vbat at WCDMA PA (N7540) C7512 3.7V (Vbattery)

6 Supply input to DC/DC conv C7527 3.7V (Vbattery)

Note: When using settings as shown in the following Tx Control window, the result at TP4 should
be 3.1V.
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Figure 29 Phoenix WCDMA Tx Control window settings
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Figure 30 Test points for voltage checking
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VCTCXO troubleshooting

Troubleshooting flow

RF component reference

Component reference table
This table shows the components used for the different bands. It can be used as a reference when
troubleshooting which components may or may not be faulty.
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GSM850 GSM900 GSM1800 GSM1900 WCDMA1 WCDMA2 WCDMA8

Reference RX TX RX TX RX TX RX TX RX TX RX TX RX TX

G7500 X X X X X X X X X X X X X X

L7500 X X X X X X X X X X X X X X

N7500 X X X X X X X X X X X X X X

N7520 X X X X X X X X X X X X X X

N7540 X X X

N7560 X X X X X X X X X X X X X X

T7520 X X

Z7521 X X

Z7523 X X

Z7540 X X X

Z7541 X X

Z7542 X X X

Z7543 X X

Z7544 X

X means that the component is used for the band in the current column.

For further reference, see Component reference schematics on the following page.
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RF block diagram

Figure 31 Component reference block diagram
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 Antenna

Antenna overview
The phone has one antenna module. The antenna module is covering GSM and WCDMA bands along with GPS
and BT. The antenna module consists of a antenna carrier and an LDS antenna, where the antenna pattern
is directly deposited on the antenna carrier.

The antenna module also acts as IHF chamber, and contains a speaker and an earpiece. The main antenna
has one feed pad for GSM and WCDMA, one feed pad for GPS, one feed pad for BT, one antenna switch pad
and two ground pads. All six pads connect to C-springs mounted on the AV-flex.

Main antenna functionality
The antenna module is functioning normally when all six contact pads take proper contact to the C-springs
on the AV-flex, and the and the antenna pattern is electrically intact.

The main antenna functionality must also be checked by measuring the transmitted power with RF coupler
at GSM900 channel 124.

Antenna troubleshooting

Antenna contacts, visual check
The antenna module has one feed pad for GSM and WCDMA, one feed pad for GPS, one feed pad for BT, one
antenna switch pad and two ground pads. Check that all pads take proper contact to the C-clips on the AV-
flex.

Antenna matching components and antenna switch related components, visual
check
There is one filtering component on GSM/WCDMA feed, two matching components on GPS feed and two
matching components on BT feed. There are also 20 antenna switch related components located at the
antenna switch connection and next to the antenna switch.

All matching and antenna switch related components are soldered on the AV-flex. Check visually that all
components are properly soldered on the AV-flex. In the case of damage you need to replace the AV-flex.

Figure 32 Antenna contacts
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Figure 33 Antenna switch related components

RM-470
RF troubleshooting

Page 4 –30 COMPANY CONFIDENTIAL Issue 1
Copyright © 2009 Nokia. All rights reserved.



5  — System Module

Nokia Customer Care

Issue 1 COMPANY CONFIDENTIAL Page 5 –1
Copyright © 2009 Nokia. All rights reserved.



RM-470
System Module

(This page left intentionally blank.)

Page 5 –2 COMPANY CONFIDENTIAL Issue 1
Copyright © 2009 Nokia. All rights reserved.



Table of Contents
Introduction............................................................................................................................................................5–5

Phone description .............................................................................................................................................5–5
Energy management..............................................................................................................................................5–9

Battery and charging ........................................................................................................................................5–9
Normal and extreme voltages ...................................................................................................................... 5–10
Power key and system power-up ................................................................................................................. 5–11
Modes of operation ........................................................................................................................................ 5–11
Clocking scheme ............................................................................................................................................. 5–11
Power distibution .......................................................................................................................................... 5–12

SIM interface ........................................................................................................................................................ 5–13
MicroSD card interface ........................................................................................................................................ 5–13
USB ........................................................................................................................................................................ 5–14

USB interface................................................................................................................................................... 5–14
MicroUSB connector ....................................................................................................................................... 5–14

User interface....................................................................................................................................................... 5–15
Display interface............................................................................................................................................. 5–15
Keyboard interface......................................................................................................................................... 5–15
Ambient light sensor (ALS) interface............................................................................................................ 5–16
Accelerometer................................................................................................................................................. 5–16

GPS interface ........................................................................................................................................................ 5–17
Camera interface ................................................................................................................................................. 5–17
Audio interface .................................................................................................................................................... 5–18
Bluetooth interface ............................................................................................................................................. 5–19
RF description ...................................................................................................................................................... 5–19

Receiver (RX) ................................................................................................................................................... 5–19
Transmitter (TX) ............................................................................................................................................. 5–20

List of Tables
Table 11 Nominal voltages................................................................................................................................. 5–10

List of Figures
Figure 34 Battery pin order ...................................................................................................................................5–9
Figure 35 Blade battery connector .......................................................................................................................5–9
Figure 36 Small (right) and wide (left) charger plugs ..................................................................................... 5–10
Figure 37 Power distribution diagram ............................................................................................................. 5–12
Figure 38 SIM interface ....................................................................................................................................... 5–13
Figure 39 MicroSD card interface ....................................................................................................................... 5–13
Figure 40 USB interface....................................................................................................................................... 5–14
Figure 41 MicroUSB connector ........................................................................................................................... 5–15
Figure 42 Display interface................................................................................................................................. 5–15
Figure 43 Keyboard interface............................................................................................................................. 5–16
Figure 44 Ambient light sensor (ALS) interface................................................................................................ 5–16
Figure 45 GPS interface....................................................................................................................................... 5–17
Figure 46 Camera interface ................................................................................................................................ 5–18
Figure 47 Audio interface ................................................................................................................................... 5–18
Figure 48 Bluetooth interface ............................................................................................................................ 5–19

RM-470
System Module

Issue 1 COMPANY CONFIDENTIAL Page 5 –3
Copyright © 2009 Nokia. All rights reserved.



RM-470
System Module

(This page left intentionally blank.)

Page 5 –4 COMPANY CONFIDENTIAL Issue 1
Copyright © 2009 Nokia. All rights reserved.



 Introduction

Phone description
RAPU is the main digital baseband ASIC in the phone. It contains functionality for both WCDMA and GSM EDGE.

Gazoo (N2200) is main audio and energy management controller for the phone.

Key components

Function Description Item ref

Main PWB 2rwa

Ant A/V flex 2rwb

UI flex 2rwc

USB Interposer 2rwd

Display flex 2rwe

Baseband ASIC EM ASIC Gazoo N2200

RF ASIC VAPAUS N7500

Processor RAPU D2800

GSM PA Front end module (FEM), quad band N7520

WCDMA PA N7540

Oscillators VCTCXO

Balun GSM

G7500

T7520

Memory Combo 512 M DDR + 1 M M3 (stacked with RAPU) D3000

Back-up battery RTC back-up battery 311 G2200

Bluetooth BTHFMRDS2.1M module D6000

GPS GPS receiver N6200

USB USB tranceiver D3300

Accelerometer N6575

Battery BL-6Q

Battery connector Tabby blade interface X2070

MicroSD connector X3200

BTB connectors Ant A/V X1500

UI X1600

Display X2400

RF connector X7400

SIM connector X2700

Charging connector X2000
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Key component placement
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System module block diagram
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Board and module connections
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 Energy management

Battery and charging

BL-6Q battery
The phone is powered by a 3-pole BL-6Q 960 mAh battery (Li-Ion). The three poles of the battery are named
VBAT, BSI and GND, where the BSI line is used to recognize the battery capacity. This is done by means of an
internal battery pull down resistor.

Figure 34 Battery pin order

The battery temperature is estimated by measuring separate battery temperature NTC via the BTEMP line of
EM ASIC (N2200). This resistor is located on the main PWB, at a place where the phone temperature is closest
to the battery temperature.

Battery connector
The battery connector is a blade connector. It has three blades;

• BSI (Battery size indicator)

• GND (Ground)

• VBAT (Battery voltage)

The BSI line is used to recognize the battery capacity by a battery internal pull down resistor.

Figure 35 Blade battery connector

Charging
This phone is charged through the smaller Nokia standard interface (2.0 mm plug). The wider standard
charger plug (3.5 mm) can be used together with a CA-44 charger adapter.
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Figure 36 Small (right) and wide (left) charger plugs

The phone can also be charged via USB using CA-101.

Charging is controlled by EM ASIC (N2200), and external components are needed to protect the baseband
module against EMC, reverse polarity and transient frequency deviation.

Charging a dead battery
Charging of a dead battery has to be carried out via an approved NOKIA charger. If the phone is charged via
USB, CA-101 must be used.

Normal and extreme voltages
Energy management is mainly carried out in the EM ASIC (N2200). that contains a number of regulators. In
addition there are also some external regulators.

In the table below normal and extreme voltages are shown when a BL-6Q battery is used.

Table 11 Nominal voltages

Voltage Voltage [V] Condition

General Conditions

Nominal voltage 3.700

Lower extreme voltage 3.145

Higher extreme voltage

4.230(fast charging)

HW Shutdown Voltages

Vmstr+ 2.1 ± 0.1 Off to on

Vmstr- 1.9 ± 0.1 On to off

SW Shutdown Voltages

Sw shutdown 3.1 In call

Sw shutdown 3.2 In idle

Min Operating Voltage

Vcoff+ 2.9 ± 0.1 Off to on

Vcoff- 2.6 ± 0.1 On to off
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Power key and system power-up
When the battery is placed in the phone, the power key circuits are energized. When the power key is pressed,
the system boots up (if an adequate battery voltage is present).

Power down can be initiated by pressing the power key again and the system is powered down with the aid
of SW. The power key is connected to EM ASIC (N2200) via the PWRONX signal.

Modes of operation

Mode Description

NO_SUPPLY (Dead) mode means that the main battery is not present or its voltage is too low (below
EM ASIC master reset threshold) and that the back-up battery voltage is too low.

BACK_UP The main battery is not present or its voltage is too low but back-up battery voltage is
adequate and the 32 kHz oscillator is running (RTC is on).

PWR_OFF In this mode (warm), the main battery is present and its voltage is over EM ASIC master
reset threshold. All regulators are disabled, PurX is on low state, the RTC is on and the
oscillator is on. PWR_OFF (cold) mode is almost the same as PWR_OFF (warm), but the
RTC and the oscillator are off.

RESET RESET mode is a synonym for start-up sequence. RESET mode uses 32kHz clock to count
the REST mode delay (typically 16ms).

SLEEP SLEEP mode is entered only from PWR_ON mode with the aid of SW when the system’s
activity is low.

FLASHING FLASHING mode is for SW downloading.

Clocking scheme
In BB5.44, two main clocks are provided to the system: 38.4MHz RF clock produced by VCTCXO in the RF section
and 32.768kHz sleep clock produced by EM ASIC N2200 with an external crystal.

32 k Sleep Clock is always powered on after startup. Sleep clock is used by RAPU for low-power operation.

SMPS Clk is 2.4MHz clock line from RAPU to EM ASIC N2200. In deep sleep mode, when VCTCXO is off, this signal
is set to '0'-state.

CLK600. The clock source is an internal RC oscillator in EM ASIC N2200 (during the power-up sequence) or
RAPU SMPS Clk.

Bluetooth and WLAN have a separate 38.4MHz TCXO clock oscillator.
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Power distibution

Figure 37 Power distribution diagram
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 SIM interface
The phone has a SIM (Subscriber Identification Module) interface including a SIM connector. The connector
is only accessible when the battery is removed.

The SIM interface consists of an internal interface between RAPU and EM ASIC (N2200), and an external
interface between EM ASIC and SIM contacts.

Figure 38 SIM interface

The EM ASIC handles the detection of the SIM card. The detection method is based on the BSI line. Because of
the location of the SIM connector, removing the battery causes a quick power down of the SIM interface.

The SIM interface supports both 1.8V and 3.0V SIM cards. The SIM interface voltage is first 1.8 V when the SIM
card is inserted, and if the card does not response to the ATR (Answer to Request), a 3V interface voltage is
used.

 MicroSD card interface
The microSD card interface has one internal interface between RAPU and EM ASIC and one external interface
between EM ASIC and the microSD card. The microSD card connector is mounted on a separate PWB, the Micro
PWB.

Figure 39 MicroSD card interface
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 USB

USB interface
The phone has an interface for USB (Universal Serial Bus). USB is a differential serial bus that provides a wired
connectivity between the phone and, for example, a PC or a headset.

Figure 40 USB interface

The phone supports USB 2.0 with High-Speed (480 Mbps).

Hot swap is supported, which means that USB devices may be plugged in and out at any time.

MicroUSB connector
This phone is provided with a specific connector for microUSB.
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Figure 41 MicroUSB connector

 User interface

Display interface
The following block diagram illustrates the display interface. Command signals and transmitted data to the
display module comes directly from RAPU.

Display backlight is provided by an external LED driver.

Figure 42 Display interface

Keyboard interface
The following block diagram shows the keyboard interface. The keyboard interface contains an IO expander
that is controlled by the I2C bus. The IO expander scans:

• The main keyboard

• The capture key

• The two volume keys

Decoupling components are implemented between the IO expander and the keys. When a key is pressed, an
interrupt is sent to RAPU.

Side keys at the UI keymat are connected directly to the RAPU GENIOs.

The LEDs at the main keyboard are controlled by a LED driver. The driver is controlled by the I2C bus.
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Figure 43 Keyboard interface

Ambient light sensor (ALS) interface
Ambient light sensor information is used to control keyboard and display brightness.

• Keyboard backlight is turned OFF, when it is not needed.

• Display brightness is dimmed, when environment lighting is dark.

The ambient light sensor is calibrated in production and can be re-tuned in service points, though not
recommended unless calibration coefficient is lost for some reason

Figure 44 Ambient light sensor (ALS) interface

Accelerometer
The accelerometer measures the static acceleration of gravity in tilt-sensing applications, as well as dynamic
acceleration resulting from motion or shock.

It has the following features:

• 2.4V to 3.6V supply voltage

• 1.8V compatible IOs

• low power consumption

• I2C output interface
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The accelerometer (N6575) is connected to I2C. One GENIO is reserved for interrupt triggered by tap
commands.

 GPS interface
The phone includes a built in GPS receiver and could operate as a stand-alone positioning device. The antenna
for GPS is located at the top of the A-cover, see section GPS antenna (page 5– 0 ).

The GPS receiver is connected to RAPU ASIC.

Figure 45 GPS interface

 Camera interface
In this phone the camera and the camera flash driver are connected directly to RAPU and controlled by the
I2C bus, port 0. The camera is supplied by separate voltage regulators enabled by the camera software
(GENIOs).

Control signals to and from the camera flash driver are connected directly to RAPU (GENIOs).
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Figure 46 Camera interface

 Audio interface
The following block diagram illustrates the audio interface of the phone:

Figure 47 Audio interface

The two digital microphones, Digi mic 1 and Digi mic 2, are connected directly to RAPU.

The earpiece is driven directly by a built-in amplifier included in EM ASIC.

The IHF speaker is driven directly by a built-in stereo amplifier included in EM ASIC.
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The vibra is driven directly by a built-in amplifier included in EM ASIC.

 Bluetooth interface
Bluetooth provides a fully digital link for communication between a master unit (the phone) and one or more
slave units (e.g. a wireless headset). Data and control interface for a low power RF module is provided by the
BTHFM module.

Bluetooth is physically integrated with FM radio in the BTHFM module ASIC, but from a functional point of
view they have nothing in common

Figure 48 Bluetooth interface

The BTHFM module is powered by VBAT and the regulated voltage VIO. For audio applications the Bluetooth
has a PCM data bus. In addition an UART (universal asynchronous receiver/transmitter) is used for data
communication and controls.

Bluetooth shares the antenna with WLAN.

 RF description

Receiver (RX)
An analogue signal is received by the phone's antenna. The signal is converted to a digital signal and is then
transferred further to the baseband (e.g. to the earpiece).

The receiver functions are implemented in the RF ASIC.

Signals with different frequencies take different paths, therefore being handled by different components.
The principle of GSM and WCDMA is the same.

RM-470
System Module

Issue 1 COMPANY CONFIDENTIAL Page 5 –19
Copyright © 2009 Nokia. All rights reserved.



Transmitter (TX)
The digital baseband signal (e.g. from the microphone) is converted to an analogue signal, which is then
amplified and transmitted from the antenna. The frequency of this signal can be tuned to match the bandwith
of the system in use (e.g. GSM900).

The transmitter functions are implemented in the RF ASIC.

Even though the GSM and WCDMA signals are sent via different components, the principle of the transmission
is the same.
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A/D-converter Analogue-to-digital converter

ACI Accessory Control Interface

ADC Analogue-to-digital converter

ADSP Application DPS (expected to run high level tasks)

AGC Automatic gain control (maintains volume)

ALS Ambient light sensor

AMSL After Market Service Leader

ARM Advanced RISC Machines

ARPU Average revenue per user (per month or per year)

ASIC Application Specific Integrated Circuit

ASIP Application Specific Interface Protector

B2B Board to board, connector between PWB and UI board

BA Board Assembly

BB Baseband

BC02 Bluetooth module made by CSR

BIQUAD Bi-quadratic (type of filter function)

BSI Battery Size Indicator

BT Bluetooth

CBus MCU controlled serial bus connected to UPP_WD2, UEME and Zocus

CCP Compact Camera Port

CDMA Code division multiple access

CDSP Cellular DSP (expected to run at low levels)

CLDC Connected limited device configuration

CMOS Complimentary metal-oxide semiconductor circuit (low power consumption)

COF Chip on Foil

COG Chip on Glass

CPU Central Processing Unit

CSD Circuit-switched data

CSR Cambridge silicon radio

CSTN Colour Super Twisted Nematic

CTSI Clock Timing Sleep and interrupt block of Tiku

CW Continuous wave

D/A-converter Digital-to-analogue converter

DAC Digital-to-analogue converter

DBI Digital Battery Interface

DBus DSP controlled serial bus connected between UPP_WD2 and Helgo

RM-470
Glossary

Issue 1 COMPANY CONFIDENTIAL Page Glossary–3
Copyright © 2009 Nokia. All rights reserved.



DCT-4 Digital Core Technology

DMA Direct memory access

DP Data Package

DPLL Digital Phase Locked Loop

DSP Digital Signal Processor

DTM Dual Transfer Mode

DtoS Differential to Single ended

EDGE Enhanced data rates for global/GSM evolution

EGSM Extended GSM

EM Energy management

EMC Electromagnetic compatibility

EMI Electromagnetic interference

ESD Electrostatic discharge

FCI Functional cover interface

FPS Flash Programming Tool

FR Full rate

FSTN Film compensated super twisted nematic

GMSK Gaussian Minimum Shift Keying

GND Ground, conductive mass

GPIB General-purpose interface bus

GPRS General Packet Radio Service

GSM Group Special Mobile/Global System for Mobile communication

HSDPA High-speed downlink packet access

HF Hands free

HFCM Handsfree Common

HS Handset

HSCSD High speed circuit switched data (data transmission connection faster than GSM)

HW Hardware

I/O Input/Output

IBAT Battery current

IC Integrated circuit

ICHAR Charger current

IF Interface

IHF Integrated hands free

IMEI International Mobile Equipment Identity

IR Infrared
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IrDA Infrared Data Association

ISA Intelligent software architecture

JPEG/JPG Joint Photographic Experts Group

LCD Liquid Crystal Display

LDO Low Drop Out

LED Light-emitting diode

LPRF Low Power Radio Frequency

MCU Micro Controller Unit (microprocessor)

MCU Multiport control unit

MIC, mic Microphone

MIDP Mobile Information Device Profile

MIN Mobile identification number

MIPS Million instructions per second

MMC Multimedia card

MMS Multimedia messaging service

MTP Multipoint-to-point connection

NFC Near field communication

NTC Negative temperature coefficient, temperature sensitive resistor used as a
temperature sensor

OMA Object management architecture

OMAP Operations, maintenance, and administration part

Opamp Operational Amplifier

PA Power amplifier

PDA Pocket Data Application

PDA Personal digital assistant

PDRAM Program/Data RAM (on chip in Tiku)

Phoenix Software tool of DCT4.x and BB5

PIM Personal Information Management

PLL Phase locked loop

PM (Phone) Permanent memory

PUP General Purpose IO (PIO), USARTS and Pulse Width Modulators

PURX Power-up reset

PWB Printed Wiring Board

PWM Pulse width modulation

RC-filter Resistance-Capacitance filter

RF Radio Frequency

RM-470
Glossary

Issue 1 COMPANY CONFIDENTIAL Page Glossary–5
Copyright © 2009 Nokia. All rights reserved.



RF PopPort™ Reduced function PopPort™ interface

RFBUS Serial control Bus For RF

RSK Right Soft Key

RS-MMC Reduced size Multimedia Card

RSS Web content Syndication Format

RSSI Receiving signal strength indicator

RST Reset Switch

RTC Real Time Clock (provides date and time)

RX Radio Receiver

SARAM Single Access RAM

SAW filter Surface Acoustic Wave filter

SDRAM Synchronous Dynamic Random Access Memory

SID Security ID

SIM Subscriber Identity Module

SMPS Switched Mode Power Supply

SNR Signal-to-noise ratio

SPR Standard Product requirements

SRAM Static random access memory

STI Serial Trace Interface

SW Software

SWIM Subscriber/Wallet Identification Module

TCP/IP Transmission control protocol/Internet protocol

TCXO Temperature controlled Oscillator

Tiku Finnish for Chip, Successor of the UPP

TX Radio Transmitter

UART Universal asynchronous receiver/transmitter

UEME Universal Energy Management chip (Enhanced version)

UEMEK See UEME

UI User Interface

UPnP Universal Plug and Play

UPP Universal Phone Processor

UPP_WD2 Communicator version of DCT4 system ASIC

USB Universal Serial Bus

VBAT Battery voltage

VCHAR Charger voltage

VCO Voltage controlled oscillator
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VCTCXO Voltage Controlled Temperature Compensated Crystal Oscillator

VCXO Voltage Controlled Crystal Oscillator

VF View Finder

Vp-p Peak-to-peak voltage

VSIM SIM voltage

WAP Wireless application protocol

WCDMA Wideband code division multiple access

WD Watchdog

WLAN Wireless local area network

XHTML Extensible hypertext markup language

Zocus Current sensor (used to monitor the current flow to and from the battery)

RM-470
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